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Welcome to the latest edition of my monthly Final Cut Pro newsletter. This is the June, 2006, edition.

The goal of this newsletter is to provide information helpful to the professional user of Final 
Cut Pro. This newsletter publishes each month. Past issues are not archived. However, key 
articles are posted on my website for your reference. All software references are to Final Cut 
Studio unless otherwise noted. 

Please invite your friends to visit my website -- www.larryjordan.biz. We now have over 110 
tutorials to help you get the most out of Final Cut!

Newsletter Contents

●     Larry Launches Fall Tour with Blackmagic Design as sponsor
●     Technique: Scrolling Text in LiveType
●     Special pricing on all Final Cut Studio Training DVDs 
●     Paul Saccone Comments on his Interview 
●     Technique: Choosing the best video codec
●     Clint's Quote on Handles
●     Get Your FREE Issue of Edit Well
●     Tips from the Classroom
●     Tips on our website
●     Technique: Compressing HDV for the Web
●     Last month's Readers Poll
●     This month's Readers Poll 
●     Technique: Creating effects by distorting images in FCP
●     Reader Mail
●     Wrap-up

Announcing Our Fall Final Cut Seminar Tour 2006 
with Blackmagic Design as Gold Sponsor

http://www.larryjordan.biz/index.html


I am delighted to make two announcements: First, our Fall 2006 Final Cut seminar tour: Pushing the 
Limits -- Final Cut Studio starts September 29. Second, Blackmagic Design has joined us as our Gold 
Sponsor!

Our Pushing the Limits Tour starts September 29 in Los Angeles and visits 12 cities across North 
America, with two seminars in each city: Supercharge your Editing with Final Cut, and The High-End of 
Final Cut Studio.

We will be visiting:

●     Los Angeles
●     New York
●     Chicago
●     Philadelphia
●     San Francisco
●     Orlando
●     San Diego
●     Portland, OR
●     Honolulu
●     Boston
●     Vancouver
●     Nashville

For a complete list of dates and seminar details, go to: www.larryjordan.biz/seminars. We have special 
early-registration pricing from now till August 15 that can save you money. 

We are grateful to Blackmagic Design for their support of this tour as a Gold Sponsor. As their CEO, Grant 
Petty, wrote: 

Blackmagic Design is dedicated to allowing the highest quality video to be affordable to 
everyone, so the post production and television industry can become a truly creative industry.

I'll have more on our tour next month. Mark your calendar and get your reservations in early -- this tour will 
be amazing and seats will fill fast!

Technique: Scrolling Text in LiveType

Creating scrolling text in Final Cut is an exercise in futility. It's awkward to create, you can't get it to pause 
at the end and it takes forever to render.

Recently, Brian, one of my students, pointed out a different way to create scrolling credits using LiveType. I 
did some additional research and discovered a very easy way to use LiveType for all your scrolling end 
credits. Here's how:

1.  Create a new LiveType project (Cmd+N)

http://www.blackmagic-design.com/
http://www.larryjordan.biz/seminars


 

2.  In the large text entry box at the bottom of the Inspector, type your text as you want it to appear in 
the credits. In this example, I've decided to capitalize the title and title case the name.

3.  Set your Out to the length of the credits you want to create, then drag the text in your text track to 
your Out. (In this example, I'm creating a three-second roll because it keeps my screen shots 
smaller. You can create any length roll you wish.) 

4.  Select your text track, click the Fonts tab in the Media Browser, and set your text to a nice 
readable format. Here, I am using Arial Rounded MT Bold Regular because it has a nice informal 
feel. Try not to use Lucida Grande, it doesn't hold up well at smaller sizes. Arial is OK, but it's so 



BORING that you could do better.

5.  Select the Text tab in the Inspector and set your font size. Here I'm using 32 point text, with 95% 
leading. (Leading controls the spacing between lines.)

6.  Move your playhead to the beginning of the Timeline.



7.  Select the Effects tab in the Media Browser and choose Scrolls and Crawls from the pop-up menu.

8.  There are five scrolls to choose from:
a. Scroll Down: Scrolls text from top to bottom with no pause
b. Scroll Up: Scrolls text from bottom to top with no pause
c. Scroll Up with Fade: Scrolls text from bottom to top, fading in the ENTIRE text clip at the 
beginning and fading the entire clip at the end. This is a different behavior from Final Cut and I don't 
like it much.
d. Scroll with Pause: Scrolls down from top and puts a pause in the middle. 
e. Scroll with Pause, Glow: Scrolls down from top, pauses in middle and does a weird glow.

For me, the only one to consider is Scroll Up. We will do the pause manually.

9.  Make sure your text track is selected, click Scroll Up, and click Apply in the lower right corner of 
the Media Browser. A new purple effect track shows up immediately below your text clip.

10.  The next two steps are the tricky part. Reduce the size of your Canvas using the pop-up menu in 
the lower left. Here, I've selected 25% view.



11.  Make sure your playhead is at the beginning of the clip, with the Effects track selected. Hold the 
Shift key down. Grab the blue baseline in the Canvas and drag it up until the top edge of your first 
text is just outside the white image area.

Here's what you've just done:

●     Putting your playhead at the beginning of the clip and selecting the effects track activates the 
keyframe at the beginning of the clip, allowing you to change the keyframe setting.

●     Holding the Shift key down constrains the movement of the baseline to either horizontal or vertical, 
but not both. This means you are only dragging the position of the text vertically and not shifting it 
from side-to-side.

●     Dragging the blue baseline changes the position of the text in the scroll so that it starts scrolling into 
view as soon as the effect starts.

12. If all you need is a simply scroll, you're done. Save your LiveType project, import it into Final Cut and 
edit it to the Timeline. But, if you want it to pause at the end, say to display a copyright notice, there are a 
few more steps you need to make.

EXTRA CREDIT



13. Select the text track and click the Text tab so your credits show up in the Inspector. Add empty 
carriage returns after your last text credit to make room for the copyright notice -- the actual number of 
returns will vary depending upon the size of the font you are using. In my example, I used 12 returns. Then 
type your copyright notice.

Secret tip: Press Option+G to type the Copyright symbol (©).

14. Select the clip in the Effects track and press Shift+k to jump to the next keyframe. (This should put you 
on the last keyframe triangle of the effect, making it glow dark. If it doesn't, press Shift+k until you get 
there. Option+k jumps to the previous keyframe.)



15. Click the Effects tab in the INSPECTOR, not the Media Browser. You'll see CanvasOffset in the Active 
Parameters box. This is the parameter that causes the text to scroll. The numbers represent the changing 
position of the text.

16. Double-click the word CanvasOffset and a dialog appears. Change the Canvas Offset Y % to -70. 
Your copyright notice should line up close to the baseline, with no words showing at the top. (The X% 
alters horizontal position, the Y% alters vertical position.)

17. To change the speed of the scroll, change the length of the effect; shorter is faster.

18. To get the copyright to hold at the end, drag your text clip so it extends past the end of the effect. Be 
sure to reposition your Out to match the end of the text clip.

19. If the beginning of your text scroll no longer aligns with the start of the effect, and it probably won't, 
press Home to move your playhead to the start of the timeline. Then, drag the baseline as you did in step 
7. 

Preview, save, and done!

This requires a bit more tweaking than I'd like to get the text to align perfectly, but this is far easier than the 
hoops we need to jump thru to create scrolling credits that pause in Final Cut.

[ Go to Top. ]

Special Pricing on all Final Cut Studio Training DVDs 

A quick reminder: All our Final Cut Studio DVD training titles produced in cooperation with Lynda.com are 
specially priced this month at $99 each -- including our newest: Learning Soundtrack Pro. You save up 
to $50 on each title!

If you want to give your Final Cut skills a boost, or learn more about the audio power hidden in Soundtrack, 
these titles are designed for you. Plus, they include all necessary exercise files.



To order, visit our store (you can also download a one-page description of what's in each title): www.
larryjordan.biz/store/index.html.

[ Go to Top. ]

Feedback: Interview Comments from Paul Saccone

I interviewed Paul Saccone, product manager for Final Cut Studio, at NAB and posted portions of the 
interview to my website (click here to listen to interview #1 and interview #2). The entire interview will be 
presented in the first issue of Edit Well.

Afterward, Paul sent me the following note:

Thanks for the great feedback, Larry. It was good chatting with you at NAB, too.

The integration concept [of all the applications working together] is relatively new, since we 
only recently put all of the apps together in a single box. I think we've done a great job with 
roundtrip integration and basic workflow. The addition of similar keyboard shortcuts and 
other consistencies that you mentioned are great feature requests. Now that the apps all 
come in one box, we're very interested in hearing from our users about the workflows they're 
using so we can continue to improve on the process.

Thanks again for the great feedback!!

[ Go to Top. ]

Technique: Choosing the Best Video Codec

This technique grew out of a comment from Diane Thompson, who wrote:

[Would you] explain the sequence settings in the GENERAL tab? I have been unable to find 
a description of each of the compressors with info about its pros and cons or best use so 
that I can make a decision which is best. (By the way, I really really appreciated last month's 
video processing tab discussion!)

Diane, email flame-throwing contests have started from much more innocent requests, but, what the heck, 
things are quiet at the moment. This is not an exhaustive discussion, as there are dozens and dozens of 
codecs with more sprouting up every day. However, I can help you understand what a codec does and 
how to choose one that will work for you.

Also, capture card developers, such as Blackmagic Design and AJA, and camera manufacturers, such as 
Panasonic and Sony, often create their own codecs to take advantage of special technology built into their 
equipment. This article will not cover those special codecs.

But, even with those restrictions, there's still lots to talk about. And I'll start with some background.

http://www.larryjordan.biz/store/index.htm
http://www.larryjordan.biz/store/index.htm
http://www.larryjordan.biz/articles/audio_saccone1.html
http://www.larryjordan.biz/articles/audio_saccone2.html


All Video is Compressed

All video that we shoot on tape or watch on TV is compressed. This has been true since the beginning of 
time -- or, well, the beginning of video at least.

Some video, like DV or HDV, is significantly compressed in a number of ways. Other video, like 
DigiBetacam is compressed less.

The reason for all this compression is that video files are HUGE and engineers are always looking for ways 
to make them smaller without sacrificing too much quality. That's where codecs (short for: COmpressor/
DECompressor) come in. A codec provides specific instructions on how to compress video to reduce it's 
size, then decompress it to "full quality" for playback. 

There are four principal goals to consider when choosing a codec:

1.  The size of the compressed file
2.  The speed of compression
3.  The speed of decompression
4.  The quality of the final image

For instance, if you are posting a file to the Internet, the size of the file and the speed of decompression are 
more important than how long it takes to compress the file in the first place or the quality of the final image. 
That is not to say these last two are unimportant, just less important.

On the other hand, if you are streaming a live event, the speed of compression is most important, because 
if you can't compress faster than real-time, no one will be able to watch the event.

As a third example, for a network television program, the speed of decompression and the quality of the 
final image are of paramount importance.

One last example, codecs are not just for moving images. BMP, PNG, TGA and TIFF are special codecs 
used to save and restore still images. They are designed to provide the highest image quality, but don't 
compress or decompress image sequences in real-time.

As a sidelight, codecs are often divided into "lossy" and "lossless." A lossless codec 
preserves all the original image quality so that when an image is restored it is 
indistinguishable from the original. TIFF and PNG are examples of a lossless codec.

A lossy codec "throws out" visual information as part of the compression process, which 
means that the compressed image does not have the original quality of the source. All video 
codecs are lossy.

No one codec provides the best of all four of these criteria. Each codec concentrates on maximizing one or 
two of the four. There is no such thing as a "perfect" codec, as different codecs were created to meet 
different criteria.

So Many Codecs, So Little Time



You've learned why there are so many codecs, however, Final Cut in some ways, makes selecting a codec 
even worse. 

Final Cut started life as a QuickTime editor, the same way that Adobe Illustrator started life as a PostScript 
editor. Both rapidly evolved into something much more, but neither forgot their roots.

Final Cut supports all the codecs that QuickTime ever supported. And QuickTime supports all (or virtually 
all) its old codecs so that you can always play a QuickTime movie, no matter how old it is.

Examples of less used (and notice I did not say "unnecessary") codecs include:

●     Cinepak
●     Component Video
●     Graphics
●     Apple Intermediate Codec
●     Apple Pixlet Video
●     Planar RGB
●     VC H.263
●     Video
●     Sorenson Video (but not Sorenson Video 3)

Now, before everyone starts shooting off emails, let me stress that for some applications in certain 
situations even these codecs can be indispensable. However, for general everyday video use, you may 
feel comfortable ignoring them.



Just for the record, not all codecs that Final Cut supports are for full-screen video. I've already mentioned 
graphics codecs like TIFF, PNG, BMP, and TGA.

There are also a lot of codecs specifically for the web. Web codecs are designed to reduce file size and 
decompress quickly, however, they take longer than real-time to compress:

●     H.261
●     MPEG-4
●     VC H.263
●     H.263
●     H.264
●     Sorenson Video 3
●     Sorenson Video

Choosing a Video Codec

As you are starting to see, the list of codecs we can use for video (fast compression and fast 
decompression) is starting to dwindle.

●     The first, and best, rule to keep in mind when choosing a video codec is to select the codec that 
matches the format of the video you are editing. Thus, if you are shooting NTSC DV, the DV/
DVCPRO - NTSC codec is the best one to choose. (Outside the US, use the DV - PAL codec with 
your PAL DV video.)

●     The second rule is if you are selecting a codec to integrate multiple video formats choose the codec 
that provides the highest quality.

●     The third rule is to select your codec based upon your final output format.

These rules are made to be broken. However, before you start breaking rules willy-nilly, you should 
probably get a better understanding of what the impact is of selecting a specific codec.

In general, image quality increases with file size. As file size increases, you need bigger and faster hard 
disks; at some point, the files are so big they can't be played from an external FireWire drive.

Here's a table that ranks codecs from higher quality to lower for SD video. The rules are the same for HD, 
but the files are bigger. Data rates and storage for NTSC and PAL are essentially equivalent.

Codec Quality
Approx. 
data rate 

Space to store 1 
hour of video 

Animation* Excellent 41 MB / second 147 GB 

Uncompressed 10-bit Very Good 26.7 MB / second 96 GB 

Uncompressed 8-bit Good 20.2 MB / second 72 GB 

DVCPro-50 Very Good 7 MB / second 25 GB 

DV OK 3.75 MB / second 13 GB 

* The Animation codec supports video, but is not generally used for real-time playback. 

Then there are specialized codecs that significantly compress video for off-line, low-resolution work that 



would not be used in the final version of the program:

●     Offline RT
●     Motion JPEG A
●     Motion JPEG B
●     Photo-JPEG
●     JPEG 2000

Choosing an HD codec

High-def (HD), in many ways, is less flexible than Standard-def. Here, you really need to choose a codec 
that matches the format of your camera. 

Additionally, having a high-quality capture card is essential to support the higher-end HD formats. Also, 
increasingly, many camera manufacturers are creating proprietary formats which makes it very difficult to 
convert video from one format to another -- the Sony XD/CAM series comes instantly to mind.

Conclusion

While there seem to be a lot of codecs to choose from, you can simplify your life by matching the codec to 
your video format. And don't worry if you aren't using lots of different codecs -- most editors only work with 
a very few.

Black Screen on Playback

Here's an interesting follow-up to this codec article. Beau Leland, in Oklahoma City, writes:

I've got an interesting problem, at least I think it's interesting. I have imported several video 
clips that a colleague had created in Serious Magic's Ultra 2 (Windows=Bad, I know, but 
that's corporate infrastructure for you). Anyway, he exported them using an 'Apple None' 
Compression at 29.97 Progressive (he did it progressive because it's for the web). Now I've 
imported them into FCP 5 and I can't get playback. The audio will scrub, but my canvas is 
blank. I've changed my timeline settings as far as time base just to see if that would do 
anything, and now I'm back to 29.97, and I've also tried changing my RT settings. Still a 
black canvas. Any suggestions? 

Larry replies: Yes, your codecs don't match. Go to the Sequence > Settings > General tab and make 
sure the QuickTime compressor settings match the format of your video file.

[ Go to Top. ]

Clint's Quote on Handles 

Clint Robertson, one of my students, wrote this short ditty after hearing my lecture on the important of 
handles (that's the extra video before the In and after the Out that we need for trimming and transitions).



Thanks, Clint, for letting me reprint it here:

On the Need for Handles

Schubert, the editor, was Chopin' on a sequence segment (with Handels) when 
Tchaikovsky, the producer, came in and demanded to see Schubert's edit.

"There is 'L' to 'Play,'" said Schubert. Upon reviewing the edit, Tchaikovsky, the Hip-Hop 
Producer, shouted "'Moz' Art!'"

Whew! And some people say classical music is no longer relevant!

Get Your FREE Issue of Edit Well

Last month, I introduced Edit Well - the Interactive Newsletter for Final Cut Studio. I'm delighted to be the 
editor, Peachpit is our publisher, and we are working with some of the best writers in the business.

I'm especially pleased that, since this is an on-line newsletter, we are able to include a variety of video and 
audio sections as well. This month features a full-length interview with Paul Saccone, Apple's product 
marketing manager for Final Cut Studio, and a video tutorial on trouble-shooting your Final Cut system; 
plus over 30 pages of techniques, tips and information on Final Cut Studio.

Launching a new publication is always more work than I expect, so it's taken us a bit longer to get the first 
issue out the door. But, have faith, it's coming. And the second and third issues are already taking shape.

Click here to register to get your first issue FREE: www.peachpit.com/editwell. 
An annual subscription is $59.

[ Go to Top. ]

Tips from the Classroom - Copying and Pasting Filters

Ramin, one of my students at LA Valley College, showed me some interesting tricks on how to copy and 
paste filters.

http://www.peachpit.com/editwell


  
  
  
  
  
  
  
  
  
  

Here's a collection of three filters applied to one image. (It's actually a pretty cool effect, as you can see 
from our snowboarder here.)

... but I digress.



To copy all the filters at once, click the words Video Filters at the top of the Viewer. Notice how all the 
filters are selected in one click?

Select Edit > Copy (or press Cmd+C) to copy all the selected filters to the clipboard. (Or, hold the 
Command key and just select the filters you want to copy.)

Select all the clips you want to paste the filters into and choose Edit > Paste.

However, there are several other ways you can paste filters. First, though, make sure you have selected 
and copied the filters to the clipboard. Then:

1.  Load the clip you want to paste the filters into the Viewer, select the Filters tab and press Cmd+V 
(Edit > Paste)

2.  Select all the clips you want to paste filters into on the Timeline, select Edit > Paste Attributes, 
check the Filters checkbox and click OK.

3.  Drag the words, Video Filters from the top of the Viewer containing the clip with filters, on top of the 
clip, or selected clips, in the timeline to which you want to paste the filters.

4.  Load the clip containing the filters you want into the Viewer and make it active. Select Make 
Favorite Effect (Option+F). Go to Browser > Effects tab > Favorites folder and drag the bin 
containing your filters onto another clip. However, I am not a fan of relying on favorite effects 
because trashing preferences destroys all favorite effects.

5.  Create a new bin in the Browser and drag the filters into the bin. However, your filter order changes 
into alphabetical order, which may change your effect in ways you don't like.

Sigh... all these choices. Now you get to pick your favorite.



[ Go to Top. ]

New! Tips on our Website

Thinking of tips reminds me of something new we've started on our web site: Final Cut Studio tips. These 
tips are culled from the best suggestions in this newsletter over the last three years.

Best of all, they're free. 

Just visit our home page and click the Tip Jar. We try to have new tips daily. Feel free to share your own 
tip and we'll add it to the jar..

[ Go to Top. ]

Technique: Compressing HDV for the Web

This technique was sent in by Bill Koepnick, who writes:

Once again I would like to contribute a helpful workflow tip that I concocted after a lot of trial 
and error (and some extensive online research). This one is for down-converting a full 
resolution HDV project from within FCP 5 to a downloadable QuickTime file that maintains 
much of the quality while cutting the video file size down to 2% of the original!

The project started with the need to post to our company website videos we shot of clients 
saying nice things about their experience working at our facility. I shot these brief statements 
with my Sony HDR-FX1, and captured them into FCP using the standard HDV 1080i 60 
presets. 

A short intro was created in Motion (at 1920x1080), and some graphics for the close were 
grabbed from the websites of the clients, prepped in Photoshop, and added to the timeline. 
The music was created in Garageband using audio clips from the clip browser. The finished 
piece runs just over a minute.

When the projects (there are two so far) were ready to export, I first did a Render All, and 
then an Export Using QuickTime Conversion:

http://www.larryjordan.biz/


 

In the dialog that comes next, click the Options button:

And then the Movie Settings > Video button where you make the following choices:



Click OK, and then click the Size button in the Video panel of the Movie Settings box and 
enter these numbers:

This cuts the picture proportionally to one third the width and height of the 1920x1080 HDV 
video frame size (one ninth of the data). Set the audio to AAC.



Be sure the Prepare for Internet Streaming box is checked, and you are ready to run the 
conversion. Your Movie Settings should look like this:



In my situation, the original self-contained HDV video file (just over one minute long) took up 
200.5 MB of disk space. It was huge on the computer monitor - and very nice looking - but 
useless for display online. After the conversion as described above, the file size was 
reduced to 3.8 MB - less than TWO PERCENT of the original size!

Of course, the big test was to upload it to our website. I recently reconstructed our entire site 
in iWeb so that I could manage it without the aid of a webmaster skilled in the obtuse 
complexities of GoLive. Adding the QuickTime file to a new Video page in iWeb was a snap, 
and I published it easily to our server space on GoDaddy.com. 

Please go to www.advantageaudio.com and click on either of the names at the bottom left of 
the Welcome page under Client Praise to see the results. You need a fairly recent (read 
powerful) computer and a high-speed connection to get the smoothest playback. Since we 
work in a technology-based industry, we made the assumption that the majority of visitors to 
our site are properly equipped to see the videos. iWeb builds bloated, often slow websites, 
but we have found it an acceptable trade-off versus hiring outside help to manage our web 
presence.

I have tried practically all the other options in QuickTime to accomplish this kind of down-
conversion for the web, and this is by far the best looking result I have found for file sizes so 
small. H.264 is pretty amazing.

Hope this helps others who have been frustrated trying to get similar results!

[ Go to Top. ]

Last month's poll

Last month I asked what your upgrade plans are with the release of the Intel/Macs and almost 500 of your 
responded. Here are the results:

http://www.godaddy.com/
http://www.advantageaudio.com/


Probably not surprisingly, the majority of upgraders favored the as-yet-unannounced PowerMac tower 
(32%). What I found interesting was the large degree of interest in using a laptop for video editing (20%). 
Also interesting was that a majority of voters (35% of the total) were not planning on upgrading at all this 
year.

I love thinking about this stuff! Thanks for sharing your opinions. To see past survey results, click here: 
www.larryjordan.biz/surveys.html.

[ Go to Top. ]

This month's poll

This month, I'm interested in learning about the kinds of projects you are working on. I first asked this 
survey two years ago, and I'm interested in learning what, if anything changed.

Click here to take the survey: http://www.pollmonkey.com/p.asp?U=1285029597

As always, your answers are confidential and you'll see the results as soon as you vote. Once you've 
voted, you can see the on-going results of the survey on the home page of our website.

[ Go to Top. ]

Technique: Creating effects by distorting images in Final Cut Pro

Sometimes, a simple effect can create some interesting results. In this technique, I want to show you how 
to use clip distortion to create an interesting opening title sequence. This is a bit tricky, so give yourself 

http://www.larryjordan.biz/surveys.html
http://www.pollmonkey.com/p.asp?U=1285029597


time to work through it. 

Distortion, also called "corner pinning," allows us to change the shape of the frame from a rectangle to a 
parallelogram, then modify it using keyframes so it changes over time.

Here's what the effect looks like when it's done: a relatively boring quad-split. The interesting part is how 
we get there. (And, if you are impatient, here's an 824 KB Quicktime movie that shows the entire effect.)

The secret to this effect is using the Distort tool to modify the corners of each clip so they seem to extrude 
into their new position. Here's how to create this effect yourself.

http://www.larryjordan.biz/goodies/distort.mov


Find four video clips and edit them to the time. In this case, my V1 clip, which forms the background, runs 
25 seconds. The top clips all run the same amount of time: 5:16. There is nothing special about these 
durations.

Position the start of the V2, v3 and V4 clips so they start about 2:00 into your sequence.

From the third pop-up menu, select Image & Wireframe. This allows you to manipulate the size of the 
frame.

From the first pop-up menu, select a scale small enough so that you can see a gray edge around your 
image. Here, I am using 50%.

Double-click the V4 clip to load it into the Viewer and select the Motion tab. Twirl down the triangle next to 
Distort so you can see the settings. Each of these four pairs of numbers represents the location of a 
corner of the clip. 

Final Cut uses 0,0 to represent the center of the image. The left-hand number controls the horizontal 
position of the image and the right-hand number controls the vertical position. Negative numbers are left of 
center horizontally and above center vertically. Positive numbers are to the right and down.

What we are going to do is set a series of distortion key frames, then manually position the corners of the 



image to give us the extrusion effect. Then, we will copy the settings to the other clips and modify them so 
each clip flies to its own corner.

Put your playhead at the beginning of the clip (Shift+i). On the keypad, not the keyboard, type + (the plus 
key), 30, and press Enter. This jumps the playhead 30 frames in. 

Click the set keyframe diamond to create a keyframe for all four corners.

On the keypad, type +, 15, Enter to jump forward 15 frames and set four more keyframes. Do this three 
times until you have four sets of keyframes, each 15 frames apart.



There's no magic to the 15 frames. The speed of an effect is determined by how close the keyframes are. 
The closer the keyframes, the faster things move.

Using the small left-pointing arrow next to the keyframe diamond, move back to the second keyframe. 
Using these small arrows guarantees that you are jumping exactly from one keyframe to another. 

Since the first keyframe determines your starting position, none of these numbers change. We will start our 
effect by changing the second set of keyframes.

From the tool palette, click and hold the Crop tool. Drag over and select the Distort tool, or type D.



Select the clip on V4 in the timeline. Notice that a cyan border now appears around it in the Canvas.

Using the Distort tool, click, hold and drag the upper left corner until the numbers in the Upper Left position 
boxes say 50, -240. One of the benefits of using the Distort tool is speed. Using the Motion tab to monitor 
settings gives you accuracy.

What I often do is use the Distort tool to let me rough-in the effect, then make final adjustments by entering 
numbers in the Motion tab.

We've now started the distortion process.

Move to the next keyframe and through a combination of using the Distortion tool and typing, make the 
following adjustments:

Upper Left 50 -240

Upper Right 
(no change) 

(no change) 

Lower Right (no change) (no change) 

Lower Left 0 0



Move to the last keyframe and make the following adjustments:

Upper Left 0 -240

Upper Right (no change) (no change) 

Lower Right 360 0

Lower Left 0 0

Changing the Upper Left position on this last keyframe helps with the ooze factor.

Select the top clip and copy it to the clipboard. Select the clips on V2 and V3. The clip on V1 acts as the 
background, so it doesn't need to move. You can move if you want to, but, in this case, there's no need.

Select Edit > Paste Attributes



Make sure Scale Attributes is NOT checked, and check Distort. You've now pasted the keyframes and all 
their settings into the selected clips.

Double click the V3 clip and change the keyframe settings so it flies into the upper left corner.

●     Keyframe 1: No change

●     Keyframe 2: Upper Right change to -50, -240

●     Keyframe 3: Upper Right change to -50, -240
Lower Right change to 360, 0
Lower Left change to -360, 0

●     Keyframe 4: Upper Right change to -0, -240
Lower Right change to 0, 0
Lower Left change to -360, 0

Double click the V2 clip and change it's keyframe settings so it flies into the lower right corner.

●     Keyframe 1: No change

●     Keyframe 2: Upper Left change to 50, 0

●     Keyframe 3: Upper Left change to 50, 0
Lower Left change to 0, 240

●     Keyframe 4: Upper left change to 0,0
Upper Right change to 360, 0
Lower Left change to 0, 240



One last thing to do is to make the timing work by offsetting the clips. Position all the clips so the V4 clips 
starts at the beginning of your timeline. Select the V3 clip and type +, 30, Enter. The clip jumps 30 frames 
to the right. 

Select the V2 clips and type +, 60, Enter. The clip jumps 60 frames to the right.

Position the start of the V1 clip so it starts at the same time as the V2 clip.

Ta-DAH! Done. (Whew!)

In my version, I added audio and a dissolve from the upper clips back to the background clip, but I'll let you 
figure that out by yourself.

I don't use this effect very much, because it's kind of a pain to set up. But it can create some very nice 
effects that you just can't get any other way. And now you know how to create it as well.

To view my finished movie, click here: distort.mov

[ Go to Top. ]

syncVUE Released

Michael Buday, of Intelligent Gadgets, sent me the following announcement:

Intelligent Gadgets is pleased to announce that syncVUE v1.0 for Intel and Power-PC 
Macintosh processors was released yesterday. For those Windows users out there, a 
Windows-XP version will be released shortly.

syncVUE allows two people on opposite sides of the planet to view the same media files 
(like dailies) and comment on them in real-time.

This is a very cool tool if you work in a geographically dispersed collaborative environment.

Click here for more info: www.syncvue.com.

[ Go to Top. ]

http://www.larryjordan.biz/goodies/distort.mov
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As always, we have lots of reader mail, including free utilities and other stuff, so let's dive right in.

[ Go to Top. ] 

- - -

Looking for FCP Rescue

David Black writes:

http://www.larryjordan.biz/index.html


It's so cool and kind of you to answer your mail. I know you are just so busy and you take 
time to read my mail. Thank you. 

OK, I did as you suggested (I do all the time when it comes to FCP 5.) and found FCP 
Rescue at the following site:

http://fcprescue.andersholck.com/

I have downloaded it and it seems to work fine. I will know when I have to trash my 
preferences. I also did a Google on Mr. Petersen and here is some information on another 
link:

http://www.imdb.com/name/nm0676760/

Maybe I have stumbled on a way to help you and others. If so, I am delighted.

Larry replies: David, thanks for the link. I'll pass it on.

[ Go to Top. ] 

- - -

XRAID Drive Problems

Dennis Rosenblatt writes:

THE PROBLEM: i replaced an apple firmware hitachi drive with the new version of that 
drive. i was told by hitachi that even though the newer version is faster, it would slow down 
to keep in step with the other 13. while it is possible that this new replacement drive was 
DOA, the xserve would not recognize the drive no matter what i tried.

SOLUTION: when i replaced the bad drive with another apple firmware drive, all was well. 
the xserve recognized it and immediately started rebuilding, ultimately finding and restoring 
about half of the original data.

This was a fairly frustrating experience. the apple manual has almost no info on replacing a 
bad drive and i could find very little on line as well. i did read online and have been told by a 
reseller - expercom, that they replace drives all the time and don't replace them with apple 
firmware drives.

So i started thinking, am i the only one who has hardware issues? unless you're a final cut 
guy working in DV, you've got a raid and one day, you'll have hardware problems. perhaps 
an occasional article about drive health and solutions would be helpful to one and all. i know 
it would have helped me.

Larry replies: Thanks for sharing your experience.

[ Go to Top. ] 

http://fcprescue.andersholck.com/
http://www.imdb.com/name/nm0676760/


- - -

More XRAID Tricks

Scott Hayward, of Firebird Worldwide writes:

I thought I would share this with you. I was dropping frames while capturing to the RAID and 
thought our camera had a problem during shooting and we were out of luck with our film. 
Well, test after test, I finally tracked the problem down to the settings on the RAID. I had 
turned off Journaling, but that still didn't fix it. Then I discovered that by unchecking "Enable 
Host Caching" in the RAID Admin program it fixed the problem and voila! no more dropped 
frames. 

Just thought you might want to know.

Larry replies: Thanks for the fix. I'll add it to my bag of tricks.

[ Go to Top. ] 

- - -

XML Thoughts

Rick Lavon, of Alan Weiss Productions, writes:

I was surprised to learn that XML is not a feature people are using or are aware of. I think 
this is one of the hottest areas of FCP production. I use two XML products almost on a daily 
basis: Spherico's Playlist2FCP, and SoundCount. I'm not affiliated with the company, but 
they are indispensable. I deal with a lot of production music, and I have to keep track of what 
cuts are used, and how much. Playlist2FCP exports an iTunes playlist via XML into FCP, 
keeping all the info such as composer, CD #, etc. As such, I let iTunes manage my music. 

I also made an Automator script that does the importing and playlist creation automatically. 
SoundCount will add up all the time each cut of music uses, which is important if you use 
licensed music. Again, this is thru XML. 

I think if more people knew what it was capable of, they would be surprised. I am also 
playing around with Traffic, an XML based add on which can do global changes to 
sequences based on XML. It is only the first version, so it has bugs, but also big potential.

Larry replies: Thanks!

[ Go to Top. ] 

- - -

Pixel Squashing

Daniel Yu writes:



Thanks especially for the summary of the non-square pixel issue regarding importing still 
images into FCP. I had a question about this. Various articles I've read regarding this issue 
over the years (including one that I believe was at Ken Stone's website) suggest that not 
only should graphics be imported into FCP at 720x540 (assuming no need to pan/zoom 
around much inside the image), but you should also first "squeeze" the image vertically in 
Photoshop down to 720x480, thereby making your image look "fat and flattened." Then 
when you import into FCP, the non-square pixels will "unflatten" and stretch back to original 
proportions. Have you heard this before? Is the Photoshop "pre-squeeze" step necessary?

Larry replies: In the past, I've recommended this. However, based on my testing with the current product, I 
think this is an unnecessary step. Just save your files as 720 x 540 (for DV) 720 x 547 (for SD) and let 
Final Cut handle the aspect ratio conversion.

[ Go to Top. ] 

- - -

Monitor Thoughts

Dave McCollum writes:

Thanks for the great newsletter. 

Now I don't want to get into some sort of pissing contest, but Sony does appear to still be 
selling CRT monitors. Officially (on their broadcast video Website), they still show the BVM 
series monitors. The PVM and other series have been discontinued. Unfortunately, the BVM 
series is very expensive, in some cases costing more than an HD-capable, fully-equipped 
FCP editing system (HW and SW and RAID).

The larger PVM series monitors are no longer available, from what a lot of people have said 
on various forums. However, the PVM14L5/1 monitor is still available at places like B & H 
(no connection to them, except as a satisfied customer). The PVM14L5/1 is an "upgraded" 
version of the monitor ("/1") that supports HD resolutions via component inputs (or via an 
optional HD-SDI card). This monitor is suitable for color-correction and is a good deal while 
they last.

With the thought of 1080i being around for quite a while, what will we do when CRTs are 
actually no longer made and sold. I guess if the average TV viewer is watching 1080i on a 
progressive format TV, then it may not matter (as the TV would have to deinterlace the 
signal before displaying it???)... something to keep up on over the next few years....

Larry replies: This rapid shift from CRT to LCD without an inexpensive way to watch for interlacing 
problems is driving me nuts. Thanks for sharing your thoughts.

[ Go to Top. ] 

- - -

Sending to Motion

http://www.larryjordan.biz/articles/lj_grfx_look.html
http://www.kenstone.net/


Johan Skaneby writes:

In the last issue you were referring to text in Motion, which reminded me of an old problem 
that I left behind but really would like to solve. Let's say I have created sequence in FCP that 
I want to continue work on in Motion. If my sequence contains dissolves - how do I keep 
them when I export/open my sequence in Motion?

Larry replies: Sadly, when you send a sequence to Motion, transitions do nat make the journey. You will 
need to reapply them in Motion.

[ Go to Top. ] 

- - -

Text Differences between Motion and Final Cut

Martin Baker, of Digital Heaven in the UK, writes:

I was interested to read your section on text size in Motion vs FCP last month. Even though 
it is inconsistent, there's actually a good reason behind this. FCP's text generators (and it 
seems also Boris) use a text size proportional to the size of the current sequence whereas 
Motion's text size is fixed. Note how FCP's text generators and Boris don't actually specify 
"Point" as the units for the text size...

In FCP land this is actually a very handy feature because it means that if you up-res an 
offlineRT sequence to DV (or say DV to HD) then your text generators will be scaled up 
automatically (this includes our DH_Subtitle plug-in, which is how I found all this out!).

Larry replies: That is VERY interesting. Thanks for letting us know - it makes a lot more sense now. You 
can see Martin's work at: www.digital-heaven.co.uk.

[ Go to Top. ] 

- - -

Moving Stuff in Soundtrack Pro

Adam Hay writes:

I had a quick question about Soundtrack Pro. By the way, I really enjoy your titles on Lynda.
com!

My question is this: In Soundtrack, when in a multi-track project, if you have a short sound 
clip with volume envelope points set up for it, is there a way to select and move both the clip 
and the envelope points around in the timeline together? I can select all the envelope points 
OR the sound clip, but not both at the same time. Is there a trick to this, or is it just one of 
those quirky things about Soundtrack?

Larry replies: Chalk it up to quirkiness.

http://www.digital-heaven.co.uk/
http://www.lynda.com/
http://www.lynda.com/
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- - -

Boosting Low Audio

Robert Rowe writes with a simple solution to a common problem:

I had some audio that was recorded at a level so low that cranking up the traditional volume 
controls still wasn't giving me the loudness I required. 

You taught me how to "stack" the audio clips by copying and pasting them in multiples to 
beef up the volume. Worked like a charm.

I don't want any credit or hype. I just wanted to give something back for all the help you gave 
me last year.

Larry replies: Robert, I'm always happy to pass on useful suggestions -- and to give credit for them.

[ Go to Top. ] 

- - -

Australian FCP User Group

Dale Ross, of Young Australia Productions, has started an Australian User Group. He writes:

Please feel free to use the link: http://fcpusers.com.au/forum and join as a member. We 
would welcome your input to make this forum a worthwhile place for people to visit. We also 
welcome any suggestions on the general design/layout of the website.

Larry replies: Dale, good luck with the user group and let us know what we can do to help.

[ Go to Top. ] 

- - -

Compression Curiosity

David Scott writes:

Thanks very much for your piece on FCP exports (as seen on www.kenstone.net). I am 
baffled, though, about the following:

Why does an exported-to-QT FCP project at "Current Settings" produce the same quality 
DVD as the same project exported as "Uncompressed NTSC 8-bit"? The former file's size is 
about one fifth of the latter, yet the quality of the DVDs produced when created in DVD 
Studio Pro appear identical.

http://fcpusers.com.au/forum
http://www.kenstone.net/


Also, why do the these files (as described above) play differently in QT Player? The 
"uncompressed" one looks exactly like a timeline or printed-to-video DV play. But the 
"Current Settings" version plays in QT like a low res jpeg. Yet these two produce identical 
DVDs?

The genesis of this inquiry is my constant quest for the absolute best quality export from 
FCP for 1) projected presentation of a DV tape and 2) creation of DVDs for distribution. 
Seems like "uncompressed" would ensure best quality but it doesn't seem to make a 
difference relative to "Current Settings".

Larry replies: Because in both cases, the highest quality of your video is equal to what's in the Timeline.

All you are doing is converting the FORMAT, not changing the quality. The quality is fixed by the video 
format you selected for editing in the sequence.

Also, the Mac is not able to decompress DV footage in real-time using software. However, when 
compressed for a DVD, it is able to decompress the DV footage and make it look great because it is taking 
longer than real-time to do so.

My recommendation is to always export using "Current settings." You'll get the best quality possible 
matching your current sequence settings.

[ Go to Top. ] 

- - -

Fixing a problem in FCP HD

Matt Krzycki, of Goodside Studio, writes:

First I want to thank you for teaching me to trash FCP prefs. It just saved my ass. Here's 
how and a bug in 4.5 you might let others know about:

AUGraphicEQ causes a "general error -39." Both my systems did it and I found reference to 
it on the web also. The solution was to trash prefs.

Larry replies: Trashing preferences is a huge cure for most FCP problems. I'm glad it worked in your case. 
(If you don't know how to trash your preferences, read this article.)

[ Go to Top. ] 

- - -

Selecting HDV Tape

Uli Plank writes:

Larry, last issue, you wrote, "Copying your footage back to MiniDV tape only 
works if you are shooting DV. (By the way, be sure to use tape specifically 

http://www.larryjordan.biz/articles/lj_trouble.html


labeled to support HDV -- MiniDV tape may not have the necessary 
bandwidth to support HDV.)"

Excuse me, but this isn't exactly right. HDV is using exactly the same bandwidth as DV (25 
mbps). It will show dropouts for longer, though, so you should advise users to buy high 
quality cassettes. We made good experiences with Sony's "Excellence" tapes as opposed to 
the "Premium" ones.

Larry replies: Thanks for your comment, I stand corrected.

[ Go to Top. ] 

- - -

Chroma-keying from HDV

Uli Plank then offers a second comment:

Larry, you wrote: "By the way, Serious Magic was showing it's PC-based 
chroma-keyer working on a MacBook Pro at NAB using Boot Camp; which 
was truly amazing. And Ultimatte was showing how it's keyer can pull clean 
keys even from DV footage."

I think that DVMatte Blast is pretty good (and fast!) for keying both DV and HDV.

I second the observation of Matt Davies regarding HDV scaled down to a better format in a 
SD timeline for chroma keying. Furthermore most HDV camcorders offer an excellent signal 
at their live analog outputs (and digital in the case of the Canon H1) which is great for 
chroma keying in the studio.

Larry replies: I just did some chroma-key work where we shot on HDV, and scaled it down to DVCPro-50. 
We were able to get excellent keys using the chroma-keyer in Motion.

Using the HD-component signal from a camera is OK, keep in mind that it is not reconstituting the lost 
material, just sending you HDV in a different format. Also, you will need a capture card to convert the signal 
into something FCP can read.

[ Go to Top. ] 

- - -

Using HD for PAL 

Uli Plank had a lot of free time last month, so he sent us a third comment:

Regarding the letter from Aaron Eoff, where you answered:

As well, slowing video won't create the "24-frame" look. That look is created 
when you first capture the image, not by slowing it down. Finally, even if you 
slow it down, you still need to play it at 25 fps in order to view it on any PAL 



monitor.

I suppose he was referring to shooting PAL for film transfer (while he really misunderstood 
quite a few things). Indeed, HDV in 50i is a better source for film transfer than 60i. If you de-
interlace it (preferably with FieldsKit) to 25p and then slow video and audio down by 4 % to 
24p, you have a pretty good source for cinema. Of course, 25p is even better, but 
unfortunately not yet supported by FCP.

Larry replies: Thanks for the additional information. PAL is not something I work with as often as I would 
like, so I appreciate everyone's help in keeping me accurate.

[ Go to Top. ] 

- - -

More on HDV and FCP

Björn Adamski writes:

Keep in mind that the analogue HD outputs from JVC and Sony HDV equipment aren't very 
good. I made some tests using the Sony A1E with BMD multibridge and the quality wasn't 
far as good as native HDV especially with detailed images. It is recommend to use a 
miranda HDV-to-HDSDI converter so that there is no D/A/D-conversion.

Currently FCP supports these HDV formats:

1080i60 (29,97 fps)
1080i50 (25 fps)
720p30 (29,97 fps)

At NAB Apple announced support for additional HDV formats:

1080p24 (23,98 fps) (Canon)
720p24 (23,98 fps) (JVC)

Larry replies: Thanks!

[ Go to Top. ] 

- - -

Proof-reading My Newsletter

Craig Burnett, and many, many others, have taken me to task regarding proof-reading this newsletter:

One suggestion, you might want to go to the It's vs. Its website, here:

http://snipurl.com/q9ul

http://snipurl.com/q9ul


I'm only a couple of paragraphs in, and there are several instances where it's was used, 
instead of the correct, "its." I'm SURE they're just typos! 

In any case, it's just one of my pet peeves, and every time I encounter it, I try to let people 
know where to go to educate themselves on the proper use of its and it's. It's just my OCD 
showing.

Larry replies: Sigh... THAT'S why I'm so excited about Edit Well -- I can afford to hire real, live proof-
readers. Thanks for your comments. It's hard to know what to do with its.

[ Go to Top. ] 

- - -

Copying Speed-Changed Clips

Tim Wilson writes:

A fix, a fix, a palpable fix ... I hope.

It seems that since the 7.1 upgrade to Quicktime, I am no longer having this speed problem 
in archived FCP projects. That is, a project which included multiple clips playing at slow 
speed, copied via that old Demon Media Manager, seemed successfully to play them back 
at their slow speed.

Just thought you'd like to know, and may want to check out for yourself.

Larry replies: Thanks!

[ Go to Top. ] 

- - -

FREE Utility - QuickTime Movie Notetaker

Josh Mellicker, the guru behind DV Creators, has written a free QuickTime utility called Notetaker.

If you ever need to watch a series of video clips and take notes, or if you need to get dailies or raw footage 
to clients or collaborators for comments, you know what a huge hassle it can be. QT Movie Notetaker was 
designed to solve that problem -- and it's FREE!

Here's where you can go to learn more or download it:http://www.dvcreators.net/qt-movie-notetaker/

[ Go to Top. ] 

- - -

Working with Image Sequences

http://www.dvcreators.net/
http://www.dvcreators.net/qt-movie-notetaker/


Victor Spangler wrote:

Help!

I have a 3D animation program that produces animation in 30fps progressive (not 29.97). 
When I try to edit the .mov that has been created the only way that I have been able to bring 
it into FC is through a 30fps j-peg format which is very small (384 X 216). Do you know of 
any compressor or any other way that I might bring it in to the computer for other effects (like 
dissolves, etc). I tried to then send it to DVD Studio Pro but it won't go through any 
conversion without getting really messed up. The only way that I can get it out of the 
computer is to take the ".mov" file directly to DVD SP and I don't have any effects. Anything 
that you can think of would be greatly appreciated. 

Larry replies: Export your .mov file as a QuickTime image sequence. Import the image sequence into FCP. 
That will solve the timebase problems. Then, create nests of those images you need to turn into dissolves.

- - -

That wraps up Reader Mail for this month -- click here to return to the main newsletter.
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Reader mail

We have tons of reader mail, including how to find the elusive FCP Rescue and a free QuickTime utility 
from DV Creators. Plus, solutions to all the nagging problems that have been driving you nuts.

Click here to view Reader Mail.

[ Go to Top. ]

Wrap-up

Well, that wraps it up for this issue. We've got some exciting stuff planned for the next few months and I'm 
looking forward to telling you about it.

Please register for one of our seminars - early registration ends August 15. 

If you want to jump-start your Final Cut skills, save $50 by buying one of our Final Cut DVD 
titles. Click here for our store. 

Finally, remember to share your opinions in our monthly poll. Click here to vote: http://www.
pollmonkey.com/p.asp?U=1285029597.

I'm grateful for all your comments and questions. I love hearing from you because when you share your 
ideas and suggestions, we all learn.

Thanks and edit well.

Larry

Subscribe to Larry's FREE Monthly

Final Cut Pro Newsletter! 

Email:    

 

[ Click here for a printer-friendly PDF version of this issue. 750 KB ]
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The newsletter is free -- but does require a subscription. Please invite your friends to sign up at www.
larryjordan.biz.

To unsubscribe, simply send me an email and I'll remove you from the list. This list is not sold, rented, or 
bartered. The only person who knows you are on this list is me.

The information in this newsletter is believed to be accurate at the time of publication. However, due to the 
variety of possible system and software configurations, the author assumes no liability in case things go 
wrong. Please use your best judgment in applying these ideas.

The opinions expressed in this newsletter are solely those of the author. This newsletter has not been 
reviewed or sanctioned by Apple or any other third party. All trademarks are the property of their respective 
owners and are mentioned here for editorial purposes only.

Text copyright 2006 by Larry Jordan & Associates, Inc.. All rights reserved. This newsletter may not be 
reproduced or published in any way, in whole or in part, without specific written permission from the author. 

Links to my website home page or articles are welcome and don't require prior permission. 
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